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FRED PAK PACKING & PROFILING 
Welcome to Fred Pak. This manual provides a “step-through” of how Fred Pak operates. 
From starting the system through to full use of the integrated Fred Dispense/Fred Pak 
programs. 
 
The manual is split into two sections. 
  

Fred Pak Packing – Details how to pack and print for Nursing Home and Community 
patients.  

Fred Pak Profiling – Details how to create Medication Profiles for packing and non-
packing patients.  

  

CONNECTING FRED DISPENSE AND FRED PAK 
 
When Fred Pak is installed, the Fred Dispense and Fred Pak programs are automatically 

linked.  The patient, dispensed medication and nursing home information in Fred 

Dispense can be accessed from Fred Pak.  There is no need to re-enter this information 

into the Fred Pak program. 

To move between the Fred Dispense and Fred Pak programs  

 Use <SHIFT + F6>  or click on the Fred Pak Icon (circled) found at the top of the 
Fred Dispense Screen to enter Fred Pak  
 

  
 Use <F6> or <SHIFT+F6> to return to Fred Dispense 

 

 
CONFIGURING PACKING AND PROFILING FORMAT OPTIONS  
 
The following formats are available in Fred Pak:   
 
MEDICATION PROFILES Baxter ATC packing  MedicoPak  

JVMedi    Webster-Pak   PersoCare Disposapak 

PersoCare PersoPak Nomad (Active Care)  Practicare Practipak  

 

Individual configuration settings for these packing formats can be found under: 

 <ALT+S> Setup 

 <P> Packing Options  
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MEDICATION PROFILES 
 
Logo File - Browse for the Pharmacy Logo to be printed on the profiles. 
 
 
Always go to profile view first? - For patients who do NOT belong in a nursing home, 
Fred Pak will go to the Profiling Screen. For patients who reside in a nursing home, Fred 
Pak can be customized to go to the Profile view or the Packing view depending on the 
following setting.  
 

 Y  When entering Fred Pak the profile view will display first. Press F9 to access 
the packing view.  

 N  When entering Fred Pak the packing view will display first. Press F9 to access 
the profiling view. 
 

 
Show Usual Doctors name under their instructions?   

 Y The doctors name will be included next to each individual drug entry in the 
Patient Medication Profile 

 N The doctors name will only print once at the top of the Patient Medication 
Profile 
 

 
Include Profile Explanation? 

 Y To include the Profile Explanation in the Patient Medication Profile 

 N To exclude the Profile Explanation from the Patient Medication Profile 
 
 

Print Profile explanation at start of profile? 

 Y Profile explanation will display at the start of the profile 

 N Profile explanation will display at the end of the profile 
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Edit Profile Explanation 
Fred Pak provides you with a standard Patient Medication Profile explanation. This 
explanation can be edited or changed to your preference.  
 
After changes have been made, you can reset the explanation to the standard Patient 
Medication Profile explanation by clicking the „Reset to Default‟ button. 
 

 
 

 
 
PMP Compliant Pharmacy? 
 
To be compliant with the Patient Medication Profile guidelines as set out by Pharmacy 
Guild the following options need to be configured as shown.  
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If you change „the PMP Compliant Pharmacy?‟ setting to N the following message will 
appear. You must enter „YES‟ to confirm you have read this message. 
 
 

 
 
 
 
Include important information section?  <Y>es or <N>o to include the important 
information section in the Patient Medication Profile. 
 
 
Include Pharmacist/Patient Disclaimer?  <Y>es or <N>o to include the 
Pharmacist/Patient Disclaimer 
 
 
Include Drug Images? <Y>es or <N>o to include Drug Images on the Patient 
Medication Profile 
 
 
Allow B&W Drug Image Printing? <Y>es or <N>o to allow Black and White Drug 
Image Printing 
 
 
Prohibit Low Quality Drug Image Printing? <Y>es or <N>o to prohibit low quality drug 
image printing. 
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BAXTER 
 
Label Type/Size <M>edium=95mm, <L>arge=110mm, <U>pside Down= 110mm 

 

 
 

 
MEDICOPAK  
 
Labels can be configured to print with a larger than normal Patient Name. The Foils can 
also print in normal or reverse date order. Dates can be printed on the foil or omitted as 
required. Photos and Dates can be printed on signing charts as required. 
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WEBSTER 
 
Inverts the printing format of the Webster Laser header card Y/N. Photos and Dates can 
be printed on Webster signing charts as required. 

 

 
 
 
JVMEDI  
 
Label Type/Size <M>edium=95mm, <L>arge=110mm, <U>pside Down= 110mm 
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PERSOCARE 
 
Allows customization of day and date printing and foil printing in normal or reverse 
day/date order. The Day and Date can start from the top of the foil. Photos and Dates 
can be printed on PersoCare signing charts as required. 
 

 

NOMAD 

Based upon the Active Care format. Paper can be <P>re Printed to A5 or <B>lank with 

two charts printing to an A4 sheet of plain paper. 
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PRACTICARE  

<Y> will print the Day Date on the left-hand side of the blisters. <N> will not print the Day 
or Date on the blisters. Photos and Dates can be printed on Practicare signing charts as 
required. Inverted Foils? Can be set to <Y> to invert the Practicare foil. The purpose of 
this is to reduce the risk of paper jams by improving how the foils feed through the 
printer. 

 

PRINTERS & SELECTING PRINTER DRIVERS IN FRED PAK 
 
FOR INFORMATION ON INSTALLING WINDOWS PRINTER DRIVERS PLEASE SEE 

PAGE 97 

Printers used for Fred Pak must support PCL6 Emulation. The printer must also be 

configured to use the Multi Purpose Tray.  An example of a printer suitable for use with 

Fred Pak is the Kyocera FS2000D 
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It is necessary to configure the Labels, Foils and Reports printer settings in Fred Pak. 

This is to ensure that the print jobs are sent to the correct Windows printer driver. 

 Go to Fred Pak > Setup > System Configuration 
 

 Set the Packing ID Label Printer to the required printer driver. (Note: Labels are 
not needed for most Laser Seal foils formats. In this scenario set the Labels 
printer to NO PRINTER) 
 

 Set the Packing Foil Printer to the Laser Seal windows printer driver 
 

 Set the Report printer to an A4 printer driver. If the reports go to the same printer 
driver as the Fred Dispense reports, set „Uses Dispense Report Printer‟ to Y. 
 

 Set the PMP Printer to the required printer driver.  
 

To comply with Patient Medication Profiling Guidelines as outlined by the Guild, a colour 
printer must be used for PMP‟s. If do not wish to comply with the guidelines and would 
like to print PMP‟s in black and white, go to Setup > Packing Options – mark your 
pharmacy as „PMP Compliant‟ - N and choose Y for „Allow Black & White Drug Image 
printing‟ 

 

 If using Laser Foils tick the box to Activate VPE Foils Printing. 
 
Note: The calibration document can be printed by clicking on the calibration 
document button. It will provide instructions on recommended settings for X axis 
and Y axis calibration settings. 
 
 

 

 <ALT + S>ave or click Save to exit Fred Pak System Configuration. 
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FRED PAK PACKING 
 
 
SETTING UP PATIENTS FOR PACKING 

 
Patients can be either community or nursing home patients. Unlike Profiling, before 

you can pack for a patient, it is essential the patient is placed in a nursing home in Fred 

Dispense. You can add the patient to a new or existing nursing home.  

A note on Packing for Community and Nursing home patients 

Packing for community patients is the same as packing for any other nursing home 

patient. A nursing home needs to be set up for each packing type and packing cycle that 

you need to pack for. 

 

For example you may set up a Community Patient Weekly home (packing beginning on 

a Tuesday), a Community Patients Weekly home (packing beginning on a Sunday) and 

a Community Patients Monthly home. 

 
 
 
Some nursing home name suggestions; 
 
 
CPM   Community Patients Monday 
 
CPTU   Community Patients Tuesday 
 
CPW  Community Patients Wednesday 
 
FHMO  Fred Health nursing home Monday 
 
FHTU  Fred Health nursing home Tuesday 
 
FHWE  Fred Health nursing home Wednesday 
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ADDING A NURSING HOME IN  FRED DISPENSE 
 
To add or edit an existing nursing home in Fred Dispense go to: 
 

 <ALT+L> Lists 
 

 <N> Nursing Homes 
 

 Press <END> or click on to Save and exit the Nursing home screen. 

 
 

 

 
 
 
 
 
 
 
 
 

The Fast Code is a 4 digit 

code (alpha, numeric or 

both) used to identify the 

nursing home. Entering this 

code into the patient details 

in Fred Dispense assigns the 

patient to the nursing home 

The Packing Cycle 

can be set to Weekly, 

Fortnightly or Monthly. 

Start of week - the day the packing cycle starts. 

Enter as 1= Monday through to 7 = Sunday 

From/To - enter a date range 

for the current packing cycle 
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CONFIGURING NURSING HOME SETTINGS IN FRED PAK 
 
Packing cycles for individual Nursing Homes can vary. These options need to be 

configured prior to commencement of packing.  

The Nursing Home details from Fred Dispense will automatically transfer to Fred Pak. 

Additional packing specific details need to be entered into the nursing home settings in 

Fred Pak. 

To access a nursing home in Fred Pak: 

 <ALT + L> Lists 

 < N>ursing Homes 

 

<F>ind 

 

 Select the nursing home from the list that appears. Use the up/down arrows to 
highlight the nursing home and press <ENTER> to select it. 
 

 

If patients exist in the Nursing Home/Community with different packing cycles, (i.e. 

are packed on a different day, or some are packed weekly where as others are packed 

monthly) then a different Nursing Home should be created for each packing cycle 
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STANDARD NURSING HOME OPTIONS 
 

 

 

  

 

 

Packing Formats - <M>edicoPak, <B>axter ATC packing, 

<A>ctive-Care, <J>VMedi Fill, <W>ebster  <P>ersocare PersoPak, 

Persocare <D>isposapack, <N>omad, P<R>acticare Practipak 
Packing Cycle – Set to 

<W>eekly,  <F>ortnightly 

or <M>onthly 

 

Start of Week – Set to 

Monday = 1 through to 

Sunday = 7 

7 Day Unit Dose – 

Each medication is 

packed into its own 

separate compartment 

and each dosage 

time is printed on a 

separate foil. 

Current Packing from - 

dates for packing cycle 

are displayed here. Use 

<+> to advance 1 week 

and <–> to rewind 1 week. 

 

Times - will default to 

B’FAST, LUNCH, 

DINNER and B’TIME. 

You can also enter 

alternative dosage 

times for each nursing 

home. You may have 

up to 8 different 

administration times per 

day. 

Pre-Printed Medico-Pak labels 

are available with pre-printed 

administration times. If these are 

used enter <Y>es. 

Pack PRN Medication into Medico-PAK Foils- 

Set to <Y> mean that PRN Medication is printed 

onto a separate foil from the normal medication. 

Set to <N> will mean that the PRN medication is 

never printed onto any foil. 

Pack Starting TimeSlot – 

used only for Baxter 

Packing. Denotes which 

timeslot the packing will 

begin from 
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MONTHLY PACKING CYCLE ADDITIONAL OPTIONS 

 
 

When the packing 

cycle is set to 

Monthly, there are 

different packing 

options available. 

One Drug per Foil – 

One Drug per foil 

option only available 

with monthly cycles set 

to One Time per Foil 

<Y>. One Drug per Foil 

<Y> will print an entire 

month‟s worth foil with 

each individual 

medication printed on a 

separate foil. 

One Time per Foil - 

One time per foil option 

only available with 

monthly cycles. A single 

foil will contain four 

weeks (28 days) worth 

of medication for each 

dosage time. 
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ADDING A PATIENT TO A NURSING HOME IN FRED DISPENSE 

All Fred Pak patients need to be residents of a Nursing Home. This must be done in 

Fred Dispense.  

From the Fred Pak program press <F6> return to Fred Dispense. 

 Select the patient from the dispensing or “WAIT” screen 
 

 Press <CTRL+I>  to go to the “PATIENT EXTRA INFORMATION” screen  
 

 Add the Nursing Home “FAST CODE” to the patient details (What is a “FAST 
CODE”?  – see „Adding a nursing home to Fred Dispense‟ page 16) 
 

 Press <END> to save details 
 

a  

To filter for all patients in a nursing home  
 

 Type = and then the nursing home code and press <ENTER> (e.g. =PCAM)  

 Search required patients by surname (e.g. SMITH)  
 

This will display only patients in the PCAM nursing home with a surname of SMITH.  
Press <ESC> to remove the Nursing home Filter. 
 
 

  

 

A preferred Doctor 

can also be entered 

here. When the 

patient is added into 

Fred Pak, the 

preferred doctor‟s 

details will transfer 

across automatically  
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CONFIGURING PATIENT DETAILS IN FRED PAK 

With the patient selected in Fred Dispense, Press <SHIFT + F6> to enter Fred Pak. If the selected patient is a NEW Fred Pak patient, 

the patient details screen will appear. 

 

 

 

 

 

Room ID –Enter a 

room number for the 

patient. (Optional) 

Notes – Will print on the Medication Profiles. The Patient notes entered 

here are displayed at the bottom right of the packing screen. An example 

of information stored in the notes field would be a patient‟s vaccination 

<ALT + S> or <END> to 

save and exit the 

Patient Details screen. 

Doctor Details – If a 

preferred Doctor has 

been entered in Fred this 

will appear automatically. 

Otherwise Doctor Details 

can be entered manually. 

Started – This is the date 

the patient was added into 

Fred Pak 

Image – Click on the image to browse for the file location of the photo to be included 

on the foil/profile. Note: will NOT print on heat seal foils. For extra information see 

Adding Photo Identification page 16. Click Clear Image to remove the current Image. 

Pack From – This the date of 

the patient‟s current packing 

cycle.  

Allergies or Adverse 

Reactions - Can be added 

in Fred Pak. The Allergies 

listed in Fred Dispense will 

come across automatically. 

Both will print on the 

Medication Profiles.  

Fred Allergies – These are any 

Allergies that have been recorded in 

Fred Dispense. These Allergies will 

appear in Fred Pak automatically. 

Active – A patient can 

be marked as Active Y or 

N. If a patient is marked 

as Active N then no foils 

will print for the patient 
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To update an EXISTING patient in Fred Pak 

 Select the required patient in Fred Pak 
 

 Press <CTRL+U> or <F8> to update patient details 
 

 

ADDING PHOTO IDENTIFICATION 
 
Take a photo of your patient using your own digital camera.  A head to shoulder photo 

taken fairly close works best.  

Save the image to c:\fredpak\photos on your main Fred Dispense/Fred Pak computer. 

 To make photo files easier to find, save files in patients‟ own name. 

For example Francis Fred Pak.jpg    

 

To add photo identification into Fred Pak   

 

 On the main Fred Dispense/Fred Pak computer click on the Image Icon in the 
<F8> patient details screen in Fred Pak 
 
 

 

 

 

 



   21 

 A browse for folder window will appear.  Browse for the C:\FREDPAK\PHOTOS 
directory 

 

 Select the patientname.jpg file and click Select 

 The patient‟s identification photo will then be visible in the patient details. The 

photo will print on the foil/medication profile. 

                 

 

 To remove a patient photo click the Clear Photo button. 
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ADDING MEDICATION  
 
ADDING MEDICATION FROM THE PATIENT HISTORY IN Fred Dispense 

 Select the patient in Fred Dispense. 
 

  <SHIFT +F6> or click on the  icon  in Fred Dispense to access Fred Pak  
 

 <A> to add medication 
 

 

 Highlight the drug to be packed from the patient history and press <ENTER> to 

display the medication details screen. 
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THE MEDICATION DETAILS SCREEN 

 

 

 

 

 

                                                                                                                                                                                                                                                              

Type - <P>acked  

<W>hen 

Required <S>hort 

Course 

<A>dditional 

Drug Directions – transfer across 

from Fred Dispense. These can be 

adjusted in Fred Pak as required. 

Desc - The tablet description can 

be edited and adjusted if the 

medication appearance changes. 

Start – This is the 

date the drug 

begins being 

packed from. 

End – This is the date 

the drug ceases to be 

packed. An end date is 

not required for standard 

ongoing medications 

QTY – Enter the number 

of tablets to be taken at 

each dosage time. 
Freq -  <D>aily, <A>lternate Days, Every <3>rd Day, 

<S>et Days Monday to Sunday, <M>onthly, <B>i 

Monthly, <Q>uarterly, <T>wice yearly, <Y>early. 

Tray No - 

Medications can be 

packed on 

separate trays. 

(Max 5 trays). 

Medications may 

need to be packed 

on a separate tray 

if a patient is on a 

large number of 

Preferred Packed Name – If 

an alternate drug name is 

required to be printed on the 

foil, enter this as the 

Preferred Packed name. This 

alternate drug name is 

limited to 15 characters. 
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HOW DOES THE FREQUENCY PRINT ON THE FOIL? 

There are several different options for drug frequency. The different frequency options 

are represented by a symbol printing next to the drug name shown at the top of the foil. 

% = Every 3rd Day  # = Alternate Days  * = Set Days 
& = Fortnightly   @ = Monthly   ~ = Bi Monthly 
^ = Quarterly   ! = Twice Yearly  = = Yearly 
   
In this example, Fosamax has a „Set Day’ frequency and therefore the foil has an asterix 
printed next to the drug description. 
 

 

 

HOW MANY MEDICATIONS CAN I PACK? 

Medicopak – 11 drugs per tray with 8 drugs maximum per single compartment. 
Websterpak – 8 drugs per tray 
Baxter ATC – N/A 
PersoCare – Disposapak – 12 drugs per tray, PersoCare Persopak – 8 drugs per single 
compartment 
JVMedi – N/A 
Nomad – 12 drugs per chart 
Practicare Practipak – 8 drugs per tray 
 

DIRECTIONS PREVIEW 

When entering new directions or re-editing existing directions, a directions preview box 
will display as shown. This allows you to see how the sigs will expand when printed on 
the foil or profile. This feature can be seen when adding in new medications or items not 
dispensed for packing and profiling.  
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PACKING TYPES EXPLAINED 

<P>acked  

Medication is standard, ongoing medication that does not require an end date. 

 

<S>hort course medication  

Is taken for a set date range, e.g. antibiotics. A start and end date should be entered. 
The medication will cease to print on foils and charts after the end date has passed. 
Short course medication displays with an asterix in the Fred Pak patient history screen.  

Short course medication will not print in the nursing home print run. Short Course 
medication will print when printing for an individual patient. You may also use the Pick 
functionality to print the Short course medication on its own. See page 51 for more 
information on how to use the Pick function. 

 

<W>hen required  

(PRN Medication) is packed in a separate foil. It will display in the patient history screen 
in Red with *When Required* Require Foil – YES/NO 

 

<A>dditional medication  

Medication the patient is using but is not packed in the foil. Examples are Inhalers, 
Lotions and Syrups. ‘Other medications not in Foil’ will print on the foil with a list of the 
additional items. Additional medications appear in the Fred Pak packing history screen in 
purple. 

Note: if using Medico-PAK foils with the Large Label name setting, the names of the 
additional medications will not be listed on the foil. Only „Other medications not in Foil‟ 
will print.  
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THE FRED PAK PACKING SCREEN 

 

<S>hort course 

medications indicated 

with an *asterix. Date range shown for 

medications currently 

displayed. Press 

the LEFT and 

RIGHT arrows to 

view any changes 

to the medication 

profile. 

Med 1/2 – indicates there are medications packed on 2 separate trays. Medications 

from tray 1 are shown. Press the number 2 to view medications from tray 2. 

Medication with a 

dosage on a set day 

will display as shown. 

Additional Medications 

appear in purple at the 

bottom of the packing 

history screen. 

Tray 1/2 shows that 

there are medications 

on a second tray. 

Press the 

corresponding number 

on the keyboard to 

view the medications 

on each tray. 

Click the green arrows or use the RIGHT or LEFT arrow on the 

keyboard to view medication changes from different date ranges. 

When required (PRN) 

medication appears in 

RED under Additional 

Medications. 

Tray Management 

– assists with 

assigning 

medications to 

different trays. 

To view medications not 

displayed on screen, 

use either the <Page 

Up> and <Page 

Down> keys or the 

<Up> and <Down> 

arrows. 
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ADDING MEDICATION NOT DISPENSED  

Patients may bring in medications that have not been dispensed in your pharmacy. In 

this instance the medication needs to be added as an outside medication. 

 

 Select the required patient in Fred Pak 

 Press <A> to add medication. The ADD ITEM (NOT Dispensed) option is in red 

at the top of the patient history screen 

 Highlight ADD ITEM (NOT Dispensed) and Press <ENTER> to select 
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At the „Add Item – NOT Dispensed‟ screen select the drug to be packed.  

 

Please note that a drug can also be selected by generic name. In this example we could 

have entered „Omeprazole‟ and then selected the brand as required. 

Configure details such as the pack type and dosage times as required.  

 

 

 If a non-Fred Dispense Drug needs to be packed type in BLANK and enter as a 

BLANK item using your own description.  
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UPDATING MEDICATION 

To update medication in Fred Pak or to view the packing details for a particular 
medication: 
 

 Select the required patient 
 

 Use the up and down arrow keys to highlight the medication to be updated 
 

 Press <U>pdate OR <F4> Edit 
 

 At the medication details screen change any packing details as required 
 

 Press <END> to save when finished 
 

 
 

GENERIC SUBSTITUTION 

To generically substitute a single drug in Fred Pak 

 

 At the packing history screen highlight the drug and press <G> 
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 Highlight and press enter to select the brand to substituteto. In this example we 
are substituting Diabex 1000mg with Glucohexal 1000mg. 

 

 Enter the date that the new brand is to be supplied from and press <ALT+O> or 
click OK 

 

 

 

 The packing history screen will then show the newly substituted brand 
Glucohexal, in this case from the 15/09/08 onwards. The previous brand can be 
viewed by pressing the left arrow on the keyboard to view any previous packing 
medication profiles. 

 

 

Note the medication 

details shown here - 

The dosage frequency, 

the date the medication 

was started and the 

date of the current 

packing cycle. 
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To generically substitute all instances of a packed drug  
 

 Go into the Activities Menu and choose Bulk <G>eneric Substitution 

 Select the Nursing Home and the drug that needs to be substituted 

 

 
 

 Click OK <ALT + O> 

 Choose the brand to substitute to 
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 Select the date that the new brand is to be supplied from 

 
 

 Enter YES to confirm that you want to apply this substitution change to all 
residents of the selected nursing home 

 

 
 

 Enter YES To apply this substitution change to ALL Nursing Homes patients 
automatically at the beginning of their next packing cycle 

 

 
 

 Press a key to the message ‘Brand Generic Substitution Completed’ 
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DELETING MEDICATION 

To delete medication from a patient in Fred Pak 

 Select the required patient 
 

 Use the up and down arrow keys to highlight the medication to be deleted. 
 

 Press <X> or  <D> to delete the medication 
 

 A message confirming that this medication is to be deleted will be displayed. 
Choose <Y> if this is correct, otherwise <N>o and the medication will not be 
deleted 

 

 

 

WHEN REQUIRED (PRN) MEDICATION 

When a PRN medication is first added to a patient‟s packing profile, the „Require Foil?‟ 

option will default to <Y>.  

This means that the foil is flagged for printing in the next nursing home print run. After 

the foil has been printed the „Require Foil?‟ option will change to N.  

Whenever the patient requires a foil for that drug again, this entry must be edited to 

Require Foil? <Y>  
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To configure When Required (PRN) medication to be printed in the nursing home print 
run 

 

 Select the patient 

 Use the up and down arrow keys to highlight the PRN Medication 

 

 

 Press <F4> to edit or  <U> to update  

 Set  the „Require Foil?‟ option to <Y> 

 

 

 Press <END> or <ALT+S> to save 
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Alternatively the PRN medication can be printed just for one individual patient. For 

further information regarding this procedure please refer to „The Pick function – 

printing for a specific drug, tray or dosage time’ on page 51 

 N.B. If a patient belongs in a Nursing Home that does NOT Pack PRN medications 

into foils as defined in Lists, Nursing Homes. The Require Foil? Y/N entry field will not be 

a valid option when adding When Required medications.  

 

TRAY MANAGEMENT  

Tray Management assists with relocating packed medications to different trays. Each 

packing format has a recommended number of medications per tray.  

If the number of medications on the tray has exceeded the maximum amount, the tray 

heading will display in red. (As shown below for Tray 1) 

To move a medication to a new tray – with the drug highlighted, use the left and right 

arrow keys to select the tray number and the space bar to select check box. 

Alternatively, use the mouse to select the check box.  
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If a patient has more than the maximum number of medications per tray, Fred Pak will 

display the following message. This message will only appear the first time the patient is 

selected in Fred Pak.  

 

 
SETTING AN INACTIVE PERIOD  
 
 
An inactive period can be used to cease packing for a patient. This would be used when 

a patient is not going to require packed medication for a period of time.  

To set an inactive period – 

 At the Fred Pak packing history screen press <I> for inactive 

 At the INACTIVE PERIOD screen as seen below, enter the date range for the 
inactive period. The reason for the inactive period can also be recorded if 
required 

 Press <END> or <ALT+S> to Save. 
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MEDICATION DOSAGE CHANGES 

When medication dosages change it is important that the directions in the medication 
details are updated. This ensures that accurate information is printed on the patient‟s 
foils, charts and medication summaries. In this example we will be changing the dosage 
of Diabex 1000mg from one tablet three times a day, to one tablet four times a day.  

 

 Select the patient 
 

 Use the up and down arrows to highlight the medication to be updated 

 

  

The date range 

of the INACTIVE 

Period is shown 

at the top right 

hand side of the 

screen. 

Click the green arrows or use the RIGHT or LEFT arrow on the 

keyboard to view the packed medications before and after the inactive 

period date. 

The INACTIVE 

Period will 

appear in the 

packing history 

screen 
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 Press <F4> to edit or <U> to update 
 

 Enter an end date. This date will be the last day that the medication is to be 
packed with the old dosage. 
 

 
 

 Press <END> or <ALT + S> to save 
 

 Choose <A> to add medication 
 

 Add Diabex 1000mg tab as a new medication. Edit the Medication Directions if 
required. 
 

 Enter a medication start date which is the day after the end date for the previous 
dose. In this example the previous dosage ended on the 25/10/07 so we will add 
a start date for the new dose as the 26/10/07 
 

 
 

 Press <END> or <ALT + S> to Save  
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MEDICATION DESCRIPTION CHANGES 
 

When a medication changes in appearance, it‟s important that the description of the 

medication is updated. This ensures that accurate information is printed on the patient‟s 

foils, charts and medication summaries. In this example we will be changing the 

description of Plaquenil 20mg Tabs from off-white coated round tablet, to off-white 

coated round peanut shape tablet 

 Select the patient 

 Use the up and down arrows to highlight the medication to be updated 

 

 

 

 Press <F4> to edit or <U> to update 

 Navigate to the Desc: Entry Field 
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 Change the description to off white peanut-shaped 

 

 Press <END> or <ALT + S> to Save, the following message will appear   

 

Choosing NO will only save the changed description for the currently selected patient. 

Choosing YES will save the changed description to:-  

1. The particular packing entry for the patient that is currently selected. 

2. The Drug description database so that it could be used when adding this drug 

to packing profiles for other patients later on. 

After choosing YES, Fred Pak will then check if you would like to update all existing 

packing entries for the drug with the new description.  

 

Answering NO will not update previously entered packing entries for this drug, 

alternatively, YES will update ALL previously added entries. When the descriptions are 

all updated Fred Pak will advise you as shown. 
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VIEWING PREVIOUSLY PACKED MEDICATION PROFILES 

 When a patient is selected, Fred Pak displays the medication list for the current 
medication packing profile. 

 Previously packed medication profiles can be displayed by pressing the LEFT 
ARROW key. Alternatively, click on the Green Arrow that points to the left found 
at the bottom left of the screen. 

 Use the RIGHT ARROW key or the Green Arrow that points to the right to 
navigate back to later packed medication profiles. 

 

 

 

 

 

The date range of the currently viewed packed medication 

profile is shown at the top right hand side of the screen. 

Click the green arrows or use the RIGHT or LEFT arrow on the 

keyboard to view medication changes from different date ranges. 
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MEDICATION ADMINISTRATION RECORDS (SIGNING CHARTS) 
 
Signing Charts are used at nursing homes for medical staff to sign when administering 

medication.   

Note: Fred Pak will only print signing grids as per dose times. For example only 
breakfast and bedtime will print if a patient only takes medications at these times.  
 
To print one signing chart for all patients in a nursing home, go to:  

 <ALT + A> Activities. Select N/home Labels/Foils 

 Enter a nursing home code or <ALT+L> to display a list of nursing homes  

 Tick the signing option. Ensure the other options are un-ticked.  

 Click Print to print signing charts. 
 

A signing chart for patient with medications in 4 dosage times 
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A signing chart for patient with medications in 2 dosage times 
 

 

To print one signing chart for an individual patient 
 

 Select the patient 

 Choose Print Labels/charts at the packing history screen 

 Tick the signing option. Make sure the other options are un-ticked  
 

 

 Click Print Chart to print the signing chart 
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THE MEDICATION SUMMARY REPORT 
 

The Medication Summary report provides a summarized view of a patients packing 

profile. It contains a list of all medications on the profile  

To print a medication summary for an entire nursing home 

 Go to Reports > Medication Profiles 

 Enter a Nursing Home code or leave blank for all Nursing Homes 

 

To print a medication summary for an individual patient 

 

 Select the patient 

 Press <M>edication Summary 

 Select a date range and click OK 

 A preview of the Medication Summary will appear on the screen. Press the printer 

icon at the top of the screen to print this report. 
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THE PRE-PACKING REPORT 

 
This report is used as an order and checking sheet.  The Pre Packing report can be 

used by the person who will pack the medication into the blister packs.  

Note that not all currently packed medications will print on the Medication Summary but 

the Pre-Packing report will only show medications that are actually being packed. For 

example an additional medication such as Ventolin will print on the Medication 

Summary. It will not print on the Pre-Packing report as it is not physically being packed 

in the packing cycle.  

Note the total column showing on the right hand side of the report. This figure is the total 

number of tablets packed in the date range the Pre-packing report was generated for. 

To print a Pre-packing report for an entire nursing home 
 

 Go to Reports > Pre-packing Report 

 Enter a Nursing Home code or leave blank for all Nursing Homes 

 
To print a Pre-packing report for an individual patient 

 Select the patient 

 Press <K> Pre-PacKing Report 

 Select a date range and click OK 

 A preview of the report will appear on the screen. Press the printer icon at the top 

of the screen to print this report. 

 

This is the 

total number 

of tablets 

packed in 

the packing 

cycle 
Additional and PRN 

Medications are 

NOT included in the 

Pre Packing Report. 
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WHAT TO DO BEFORE PRINTING A NEW PACKING PERIOD 
 

 Ensure all medication changes have been entered for the nursing home patients 

 Go to Activities > Advance Packing Dates 

 Enter the Nursing Home code or press <CTRL+L> and the list of Nursing Homes 
will be displayed. Select the required Nursing Home 

 Fred Pak will automatically enter the expected dates. As shown here the current 
packing cycle is the 15/09/2008 to the 21/09/2008. „Update to be current from‟ is 
the date that the packing cycle will be advanced to.  

 USE the <+> and <-> keys to advance and rewind the „Update to be current from‟ 
dates if the packing cycle dates need changing. 

 

 

 Press Enter or click on Update Dates to advance the packing dates 
 

 Answer YES to the message „Sure about advancing packing dates?‟ if sure. 
 

 

 Fred Pak will acknowledge that the packing dates were advanced for the 

nursing home and all its patients with the following message 
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PRINTING FOILS, LABELS & CHARTS FOR A NURSING HOME 
 

 Press <ALT+A> or click on the Activities Menu 

 Choose Labels/Charts/Foils or Fill(JVMedi/Baxter ATC formats only) 

 Enter the Nursing Home code or press <CTRL+L> and the list of Nursing Homes 
will be displayed. Select the required Nursing Home 

 Depending on which option was chosen from the Activities menu, a printing 
option will be automatically selected. In this example we chose Foils so foils is 
automatically selected. Foils can be unselected and another printing option 
selected if necessary. 

 

 

 When all details are correct click Print 

 The following message may appear when printing Foils/Labels/Charts from Fred 

Pak if you have nursing homes set to use different packing formats. (I.e. one nursing 

home prints Medicopak and the other Websterpak). This is to remind you to ensure that 

the correct stationary is loaded. 
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PRINTING FOILS LABELS & CHARTS FOR A SINGLE PATIENT 
 

 Select the required patient  

 

 Ensure all medication changes have been entered for the patient 

 

 Choose <P>rint Labels/Charts 

 

 
 

 Use <ALT + L> to select Labels, <ALT + F> to select Foils or <ALT+S> to select 
Signing Charts. Alternatively tick the box next to the item that needs to be 
printed. In the example below we have chosen Foils.  

 

 Select a „Print from‟ date range.  

 

The „Print from‟ date range will default to the packing cycle date range of the 
nursing home that the patient belongs to. This date range can be changed if a 
different date range is needed. Use the drop down arrow to access a calendar to 
select a date. Alternatively the <+> and <-> keys can be used to move forward or 
back by a week at a time. A completely new date can also be typed in if 
necessary.  

 

 <ALT + O> or click OK when the details are complete to print the foil, label or 
chart. 
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THE PICK FUNCTION – PRINTING FOR A SPECIFIC DRUG, TRAY 

OR DOSAGE TIME 
 

The pick function in Fred Pak allows you to print specific medications, trays or dosage 

times.  This feature is very useful if; 

 

1. Just one foil has been changed and needing reprinting  

2. NOT all of the patients regularly packed medication will be required 
during the current packing period. 

 

To print a specific medication, tray or dosage time 

 Select the required patient 

 

 Choose <P>rint Labels/Charts 

 

 Use <ALT + L> to select Labels, <ALT + F> to select Foils or <ALT + S> to 

select Signing Charts. 

 

 Select a „Print from‟ Date range 

 

 Choose <ALT + P>ick or click in the Pick checkbox 
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 Select the item to be printed and click OK. In this example we are printing the 
Losec on Tray 2.  

 

 

 

 

 Press <ALT + O> or click OK to print. 

 

 

 

 

 

Deselecting Trays will alter what medications display. Only 

medications for selected trays will appear in the pick screen. 
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THE PULL DOWN MENUS 

<ALT> or <F10> highlights the menu bar at the top of the screen. To open the menu option 

move the cursor with the <Left> and <Right> arrow keys and press <ENTER>. Alternatively  

press <ALT> and the highlighted letter of the menu option required. E.g. <ALT + A> will 

select the Activities menu. You can also click on the Menu required with the Mouse Cursor. 

THE FILE MENU 

<ALT + F> pulls down the “File” menu. The “File” menu contains: 

 

 Browse Medication 

Displays a summary of the medications packed in Fred Pak.  If a patient is selected, 
Browse Medication will only display the selected patient‟s medications.  To view all 
medications packed, clear patients from the screen using the F12 key before 
accessing Browse Medications. 

 Browse Patient 

Displays the patient records for patients that exist in Fred Pak 

 Browse PakTrans 

Browse PAKTRANS is only used with the JVMedi/Baxter ATC Packing formats. Transactions 
are created for each packed medication in each packing cycle or batch. 

 Maintenance  

This option allows for Support to assist you if required. It can only be accessed with a 
password. 

 View Problem  

This option allows for Support to assist you if required. View problem shows a log of 
any issues that may have occurred while using Fred Pak 

 Exit   

<ALT + X> Exits Fred Pak 
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THE PACKING MENU 

<ALT + P> pulls down the “Packing” menu. The “Packing” menu contains: 

 

 Update Patient Details <CTRL + U> or <F8> 

The patient details that can be updated through Fred Pak are 

- The patient‟s room number at the Nursing Home 

-  The current packing date 

-  The Doctor and Doctor‟s Phone number 

- Whether or not the patient is currently active 

-  Any allergies or adverse reactions the patient may have 

- The patient notes.  

All other patient details must be edited through Fred Dispense 

 Edit Patient Notes  <CTRL + N> 

A short cut to accessing the patient notes in the patient details screen 

 Delete Medication  <X> 

Used to delete medication from a patients packing profile 

 Clear Screen   <CTRL + C> or <F12> 

Clears the screen 
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THE ACTIVITIES MENU 

<ALT + A> pulls down the “Activities” menu. The “Activities” menu contains: 

 

 N-Home LABELS                  <L> 

Used to print labels for all patients in a nursing home packing cycle 

 N-Home CHARTS                  <C> 

Used to print Signing Charts for all patients in a nursing home packing cycle 

 N-Home FOILS\HEADER CARDS                      <F> 

Used to print Foils\Header Cards for all patients in a nursing home packing cycle 

 N-Home FILL         <I> 

Used to create a nursing home packing cycle batch for the JVMedi packing format 

 ADVANCE PACKING DATES   <A> 

This calculates and advances the date range for the next Nursing Home packing 

cycle. 

 BULK GENERIC SUBSTITUTION  <G> 

This allows for bulk generic substitution between brands of a drug. For further 

information see Bulk Generic Substitution Page 33 
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THE REPORTS MENU 

<ALT + R> pulls down the “Reports” menu. The “Reports” menu contains: 

 

 Active Patient List 

A list of patients currently marked as ACTIVE. Active patients will be included in any 

packing run generated for the Nursing Home in which the patient resides 

 Medication Summary 

       Summarizes the medications in the packing profile for all patients in a nursing home 

 Pre-Packing Report  

A report that lists all medications packed in a foil, for all patients in a nursing home. 

Note that additional medications will not appear in this report as they are not actually 

packed. 

 View Last Report  <CTRL + V> 

The last report generated will be displayed 

 

THE LISTS MENU 

<ALT + L> pulls down the “Lists” menu. The “Lists” menu contains: 

 

 Nursing Homes 

A list of all Nursing Homes entered in Fred Pak 
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THE SETUP MENU 

<ALT + S> pulls down the “Setup” menu. The “Setup” menu contains: 

 

 Owner Details  

Details of the owner including name, business name, address, phone and fax 
numbers. 

 Packing Options  

Each packing format has packing options specific to the format. These options are 
normally configured at the time of installation.  

 System Configuration 

Details of which printer driver each part of the packing routine will print to. 

 Fred Pak Options 

Fred Pak options can only be accessed when the program is in Maintenance Mode. 
Used by support to configure extra packing options. 

 

THE HELP MENU 
 
<ALT + H> pulls down the “Help” menu. The “Help” menu contains: 

 

 

 View Fred Pak Manual 

The Fred Pak Manual can be opened, viewed and printed  

 About Fred Pak 

About Fred Pak displays detailed information about the current version of Fred Pak. 
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MAKING CHANGES TO THE OWNER DETAILS 
 

Whenever making changes to the Business name or approval number, you must 

contact Fred Help. Fred Pak will require new access codes if the Business name is 

changed. 

Address, Phone and Fax details can be updated without contacting support. 

 

 Press <ALT+S> Setup 

 <O> Owner Details 

 Use <TAB> to access the field you need to update 

 Update the details 

 Press <END> to save 
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FREQUENTLY ASKED QUESTIONS 
 

How do I stop packing for a patient? 

If the patient temporarily or permanently stops needing packed medication, you can 

mark the patient as inactive.  

To make a patient inactive: 

 Select the required patient 

 Press <CTRL + U> or <F8> - Update 

 In the ACTIVE field enter <N> to make a patient INACTIVE 

 Press <END> to Save 

To make the patient active again: 

 Select the required patient 

 Press <CTRL + U> or <F8> - Update 

Move to the ACTIVE field and enter <Y>  

 Press <END> to Save 

If the patient is deceased mark them as such in Fred Dispense: 

 <SHIFT + F6> to enter Fred Dispense 

 Select the patient 

 <CTRL + I> then change the patient status to <D> 

 Press <END> to Save 

 

What should I do if some patients in a nursing home are packed on a different day 
to others? 

A separate nursing home should be set up for each packing start day. 

 

What should I do if a nursing home has more than one packing cycle i.e. some 
patients are packed for weekly and others fortnightly? 

A separate nursing home should be set up for each packing cycle. 
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How do I advance packing dates? 

You should ideally be printing the foils for all patients in a nursing home together. 

Therefore, you should be advancing the packing dates for all patients in that nursing 

home at once, directly before you print their foils. 

To advance nursing home packing dates: 

 Press <ALT + A>  Activities 

 <A>  Advance Packing Dates 

 Enter a nursing home code and press <ENTER> or press <CTRL + L> to view a 
nursing home/hospital selection list and press <ENTER> to select the required 
nursing home. 

 Fred Pak will display the current packing cycle and will calculate the dates of the 
next cycle to be packed for that Nursing Home 

 Press <ENTER> to update the packing cycle dates 

 

How do I see what medication I packed for a patient last time? 

Print a medication summary report. 

 Select the patient   

 Click on Medication Summary at bottom of the screen  

 Enter date required   

 

How many medications can I pack? 

Medicopak – 11 drugs per tray with 8 drugs maximum per single compartment. 

Websterpak – 8 drugs per tray 

Baxter – N/A 

PersoCare – Disposapak – 12 drugs per tray, Persopak – 8 drugs per single 
compartment 

Practicare Practipak – 8 drugs per foil 

JVMedi – N/A 

Nomad – 12 drugs per chart 

Note: You may not realistically be able to pack the maximum number of medications into 

each compartment due to the size and shape of the individual tablets or capsules you 

are packing. 

 

How many foils can I pack for one patient? 

You can print up to 5 trays for one patient. 
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How do I pack medications not dispensed in this pharmacy? 

 Select the required patient in Fred Pak 

 Press <A> to Add medication 

 You will see the option ADD ITEM (NOT Dispensed) in red.  

 Press <ENTER> 

 The ADD ITEM screen will appear where you can enter the drug name for selection. 

 You can then continue to select the standard drug packing options of type, start date, 
end date,  frequency, tray number and administration times 

 

What do I do when a patient stops taking a particular medication? 

If a patient stops taking a particular medication, edit the medication and enter an end 

date. The medication will cease to be packed after the end date has passed. 

 

Why didn’t all medications for my patient print? 

Check that there is no end date set on the item that did not print. Also check that the 

medication start date for the item is within the printing period. 

 

How do I reprint the current packing cycle foils/labels/charts for one patient? 

 Select the required patient in Fred Pak 

 Press <P> to print Labels/ Charts 

 Press <F> to select Foils, <S> to select Signing Charts or <L> to select Labels 

 Check that the packing dates shown are those that you wish to pack for 

 You can also use the pick function to select specific drugs if not all medications are 
required to be reprinted. 

 Press <ENTER> to print 

 

How do I reprint the current packing cycle foils/labels or charts for one nursing 

home? 

 Press <Alt + A> to enter the Activities menu 

 Select  <L> N-Home LABELS ,  <F> N-home Foils , <S> N-home Charts or <I> N-
home Fill 

 Select the required nursing home 

 Check that the packing to date is correct. If not, update the dates under Alt <A> 
Activities menu and then <A> Advance Packing Dates. Select the Nursing home 
whose packing dates you wish to check and update using the <+> or <-> keys as 
required. Then return to N-Home Labels/Foils 

 Press <Enter> to print selection 
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When do I use End Dates when packing medications? 

End dates should be used when a patient is taking medication for a limited period of time 

e.g. for antibiotics or when a patient needs to stop taking a medication. 

 

Why can’t I see all the medications for a patient on the screen? 

Not all of a patient‟s medications may show on the screen at once if more than 5 

medications are being packed. Use the DOWN ARROW to scroll down the screen to see 

any other medication that is being packed for the patient. Alternatively, use your PAGE 

DOWN key. 

If medication is packed onto separate trays not all medications may be visible at first 

glance. To see medications packed on to other trays press the corresponding tray 

number on the keyboard. For example, to view medications packed on tray 2 press the 

number 2 on the keyboard. Alternatively click no the numbered buttons shown at the 

bottom of the screen. If medications are packed on more than 1 tray, this will be seen 

towards the bottom left hand side of the screen by viewing the selected tray numbers. 

Tray numbers not in use will be grayed out. 

 

 

How do I know what packing type to use? 

   

 

Packing Type Use 

P -  Packed Default setting for all medication required 

to be packed 

S  - Short Course Antibiotics, Anti-nausea, Prednisolones 

W - When required  Analgesics, Anti-nausea 

A  - Additional Medication 

(Items unsuitable for packing into 

blister packs) 

Creams, liquids, patches, inhalers 
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FRED PAK PROFILING 

ADDING A NEW PATIENT TO FRED PAK PROFILING 
 
It is important to note that unlike Packing, a patient DOES NOT need to belong to a 

Nursing Home to be able to generate Patient Medication Profiles. 

With the patient selected in Fred Dispense, press <SHIFT + F6> to enter Fred Pak. 

Alternatively, click on the Fred Pak Icon (circled) found at the top of the Fred Dispense 

Screen to enter Fred Pak. 

 

The Fred Pak patient details screen will appear the first time the patient is entered into 

Fred Pak.  

 

 
 The patient details will transfer across from Fred Dispense automatically. For 

more information on the patient details screen see page 21 of the packing 

section of this manual. Note the patient in our example is not in a Nursing Home.  

 <ALT+S>ave or <END> to exit the patient details screen. 
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NAVIGATION FROM FRED DISPENSE 

 

If the patient DOES belong in a Nursing Home and the packing option is set to “Always 

go to profile view first – N” you will be taken to the Packing Screen. Press F9 or click on 

the Medication Profile button to enter the Profiling Screen. (For more information about 

packing options see page 5) 

 

If the patient DOES belong in a Nursing Home and the packing option is set to “Always 

go to profile view first – Y” you will be taken to the patient profiling screen.  
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Always go to profile view first? Y/N - is a local setting and can be set to behave 

differently at Individual workstations (hint: set it to N at workstations where Fred Pak will 

be used mainly for DAA Packing  and Y where Fred Pak will mainly be used for Profiling. 

If the patient DOES NOT belong to a Nursing Home, you will be taken directly to the 

Medication Profile Screen.  

 

 

 

           
 THE PACKING SCREEN THE PROFILING SCREEN 

INCLUDING MEDICATIONS IN THE MEDICATION PROFILE 

REPORT 
 

INCLUDING MEDICATIONS 

The patient‟s dispensing history from Fred Dispense is automatically displayed in the 

Patient Medication Profile screen. The following information is shown 

 The first date the medication was dispensed 
 

 The last date the medication was dispensed 
 

 How many times the medication has been dispensed 
 

 The Brand name and the Generic name for the drug 
 

 The directions entered for the medication the last time it was dispensed 
 

F9 

Note: the „Patient Medication 

Profile screen title is in RED 

Note: the „Packing Profile 

screen title is in BLACK 

F9 
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Each drug from the patient history must be „included‟ so the drug will appear on the 
Medication Profile Report. Included medications can be identified by the green tick that 
shows in the profiling screen.  

 

 

 

 

 

 

 

To include medication in the Medication Profile Report –  

 Highlight the medication 
 

 Press <I>nclude in the profile or click on the Include in Profile button 
 

 

 

 

The selected 

drug is 

highlighted 

in yellow 

Included Medications are 

shown with a white 

background and a green tick 

Excluded Medications will display with a grey background 

and will NOT have a green tick. These medications will 

not print on the Medication Profile Report  

Use the green 

arrows to change 

the order included 

medications print 

on the profile. 

When an excluded 

medication is 

selected the arrows 

will be disabled. 
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The Medication Details screen will appear. 

 

 Enter the dosage times  
 

 Enter the „Purpose of Medication‟ and „Specific Instructions‟ notes 
 

 Enter the prescriber name if different to the usual prescriber. For example – a 
specialist doctor or SELF for OTC Medications. 
 

 Enter a drug description if required  
 

 <ALT + S>ave or <END> to save and exit the Medication Details screen 

 
 
 

 
 

 

Important note regarding patients with PACKED Medication: 

Any medications packed in the Fred Pak Packing after the patients Fred Pak medication 
profile is initially created, will be automatically be added and flagged as „Included‟ in the 
Patient Medication Profile  section of Fred Pak. 

 

 
 

Specific Instructions can be entered when 

the instructions do not comply with standard 

dosage times and drug directions.  



   66 

EXCLUDING MEDICATION 
 
To exclude medication from the medication profile report –  
 

 Highlight the medication 
 

 <E>xclude or click on the Exclude button found at the bottom of the screen 
 

 The green tick will then be removed and the medication will no longer be 
included in the Medication Profile Report. 

 

 

 

MEMORISE CHANGED INFORMATION? 

When saving an included medication, a message may appear as shown below. Each 
time a Drug Purpose, Specific Instruction or Tablet Description is entered you will be 
asked if you wish to memorize this information.  

Memorizing the information will mean that the next time this medication is included on a 
future profile, the memorized information will be included automatically.  
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EDITING MEDICATION DETAILS 

The medication must be included in the medication profile report to be edited. 

 
 Highlight the included medication 

 Press Edit <F4> to edit included medication 

 

 
 

 If you dispense Diabex 500mg with the directions 3 times a day, then a new script 
is presented with directions of 4 times a day, once dispensed these new directions will 
be transferred into the profile.  It is important to remember you will need to change the 
dosage times in the profile to complete the update.   

 

FLAGGING MEDICATIONS AS SPECIFIC INSTRUCTIONS & WHEN REQUIRED  

 

 

 

 

Flagging a drug with (S)pecific instructions will disable the BFAST, LUNCH, DINNER, BTIME section. This is used to show 

that the specific instructions entered for the administration of this drug do not fit the B‟FAST, LUNCH, DINNER, B‟TIME format. 

Flagging a drug 

as (W)hen 

Required will 

disable the 

BFAST, LUNCH, 

DINNER, BTIME 

section. This is 

used to show that 

When Required 

(PRN) medication 

does not fit the 

B‟FAST, LUNCH, 

DINNER, B‟TIME 

format 

An (S) shows 

that this drug has 

been flagged as 

having specific 

instructions (PRN) shows that 

this drug has been 

flagged as a When 

Required medication 

Standard 

medication that 

has not been 

flagged will 

appear with the 

dosage 

instructions in the 

BFAST, LUNCH, 

DINNER, BTIME 

format 
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PRINTING ALL BRANDS ON THE PROFILE 
 

You can print all brands or only selected brands of a drug on the medication profile. In 

the medication details screen Print All Brands is ticked by default.  
 

 
 
Un-ticking Print All Brands displays the Select Brands screen. Here specific brands can 

be selected and unselected as required. Only the selected brands will print on the 

profile. 
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SAVING DRAFTS AND PRINTING DRAFT MEDICATION 

PROFILES 
 

 
TO SAVE A DRAFT MEDICATION PROFILE 

 

 <ALT+D> Save Draft or click on the Save Draft button. Enter the Pharmacist 

initials of the person creating the profile. 

 
 

              
 
 

 A message will appear at the top right of the profile screen to show that the draft 

has saved. 

 

 
 

 

VIEWING, REPRINTING OR DELETING PREVIOUSLY SAVED 

DRAFT, ABBREVIATED OR COMPLETED PROFILES  

 
 

 Press F2 to display the list of Draft, Abbreviated and Completed Medication 

Profiles. Selecting the corresponding letter or use the up and down arrow keys to 

highlight the profile and press <ENTER> to view and print.  Profiles can also be 

deleted by highlighting the desired profile and pressing the <DELETE> key. On 

pressing delete a prompt will appear seeking confirmation. 
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 A PDF Viewer will launch the profile. Note that the Draft Profile will appear with a  

DRAFT COPY Watermark. 

 

If a different 

prescriber to the 

preferred doctor 

has been entered 

in the Medication 

Details screen, 

the prescriber‟s 

details will print on 

the profile as 

shown. 

The Pharmacy 

Logo can be 

configured to 

print on the 

profile. See 

Packing Options 

Page 5 

The Pharmacist 

initials entered 

when printing 

the profile will 

expand to show 

who the profile 

was prepared 

by. 

.This is a unique identifier for the medication profile. It consists of the 

Patient number (36322) the date (080917 = 17
th
 of Sept 2008) and 

the time the medication profile was generated (102017 = 10:20:17am) 

Medication 

images print here. 

If no image is 

available this box 

will be empty. 
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PRINTING THE COMPLETED MEDICATION PROFILE 
 

 <ALT+P>rint Profile or click on the Print Profile button. Enter the Pharmacist 
Initials of the person creating the profile 

            
 

 

 
 

 

 

 

 

 

 

Medications flagged with Specific 

Instructions or as When Required display 

as shown. The BFAST, LUNCH, DINNER, 

BTIME dosage section is disabled. 

Standard Medications will use 

the BFAST, LUNCH, DINNER, 

BTIME section to display the 

dosage instructions.  



   72 

The following is the pharmacist and patient disclaimers. These may or may not print as 

part of the medication profile. This is determined by a setting in the Setup Menu > 

Packing Options > Include Pharmacist/Patient Disclaimer? 
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PRINTING THE ABBREVIATED MEDICATION PROFILE 
 
The Abbreviated Medication Profile can be printed via the Activities Menu  

First Select the patient then press <ALT+A>, B - Print Abbreviated Medication Profile. 

The Abbreviated Medication Profile is a medication profile without the signing sheets and 

disclaimer information that is included in a standard Medication Profile. 

 

 Enter the pharmacist‟s initials when prompted 
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THE PULL DOWN MENUS – ADDITIONAL PROFILING OPTIONS 
 

See page 53 for more Pull Down Menu options. 

<ALT> or <F10> highlights the menu bar at the top of the screen. To open the menu 

option move the cursor with the <Left> and <Right> arrow keys and press <ENTER>. 

Alternatively press <ALT> and the highlighted letter of the menu option required. Eg 

<ALT + A> will select the Activities menu 

 

 

THE ACTIVITIES MENU 

<ALT + A> pulls down the “Activities” menu. The “Activities” menu contains: 

 

 

 Print Patient Medication Profile 

With the patient selected this option will print a Patient Medication Profile 

 

 Print Abbreviated Medication Profile 
 

With the patient selected this option will print an abbreviated Medication Profile 

that will exclude the purpose and additional instructions. This is ideally suited for 

other members of the patient‟s healthcare team. 
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THE REPORTS MENU 

<ALT + R> pulls down the “Reports” menu. The “Reports” menu contains: 

 

 Profile Analysis Report 
 

 The Profile Analysis Report will provide you with information on how many 
Profiles have been generated in a selected date range.  
 
 

 

 
 

 

The report can be generated for <A>ll Patients or filtered by <N>ursing Home or 

N<o>n Nursing Home patients.  For Hospital Sites the report can be filtered further by 

Wards. 

A date range for 

the report can be 

specified here 

The report 

can include 

Drafts – Y/N 

The total Number of 

Profiles completed 

in the date range 

specified 

The days in the date 

range specified where 

Medication Profiles 

were completed. 

A time range for 

the report can be 

specified here 
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 Detailed Profile Report- Similar to the Profile Analysis Report. The report 

provides a detailed listing of patients that Patient Medication Profiles were 

generated for.  

 

  

 

 
 

 

 

 

 

  

The report can be generated for <A>ll Patients, <N>ursing Homes, or N<o>n Nursing 

Home patients. For Hospital Sites the report can be filtered further by Wards. 

A date range 

for the report 

can be 

specified here 

The report 

can include 

Drafts – Y/N 

The report can 

be ordered by 

Date, Patient or 

Nursing Home 
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APPENDIX 
SUPPORTED PACKING FORMATS EXAMPLES 

 

Medicopak Cold Seal 
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Webster Multi Dose Header Cards 
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Webster 7 Day Unit Dose Header Cards 
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Webster Cold Seal 

 

 
 

 

 

 

 

 



   81 

Nomad Charts Blank A4  
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Nomad Charts Pre-Printed A5 
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Persocare PersoPak Foils 
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Persocare PersoPak Labels 
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Persocare DisposaPak 
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Practicare Foils 
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Practicare Labels 
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INSTALLING AND CONFIGURING PRINTER DRIVERS 
 

INSTALLING A WINDOWS PRINTER DRIVER FOR LASER SEAL MEDICOPAK 

PERSOPAK AND WEBSTERPAK 

(For heat seal printer driver installation, please contact support 1300 73 1888.) 

Fred Health supports Kyocera printers with PCL6 emulation for Laser seal foils printing. 

It is a requirement that Laser Seal foils be printed through the Multi Purpose (MP) tray. 

Using the cassette trays will void the manufacturer‟s warranty. 

It is encouraged that you use a printer that is compatible with a separate output tray (for 

example a Kyocera PT-310 output tray) to allow for straight through label printing. The 

Kyocera models that support this output tray are C5015N C5030N and FS3900 

Please Note – The WebsterCare Cold Seal Laser Labels (A5 Laser Sheet) format 

requires a HP Laserjet 6P printer driver 

Installing a Windows printer driver for the Kyocera FS1920 multipurpose tray. 

In this example we are installing a FS1920 Driver. The steps to install a printer driver will 

be similar for most Kyocera printers. Please install the printer driver designed for the 

model of printer you are using. 

 Go to the Windows Start menu > Settings > Printers & Faxes 

 Double left click on Add Printer 

 Click Next 
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 Make sure that Local printer attached to this computer is selected and click Next. 
 

 

 

 

 Select the printer port that the printer is connected to. 

 

 

 

 



   90 

 Select the Manufacturer and Printer for the printer you are using. 

 

 

 If prompted with a message that a driver already exists, choose to keep the 
existing driver as shown below. Click Next. 
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 By default, the name of the printer will be listed as the name of the driver. 
Change this to something more meaningful such as Medicofoils or Websterfoils. 
In this example the printer will be called COLDFOILS. Select No to the question 
that asks if you would like this printer to be the default printer and click Next. 
 
 

 

 Choose to share the printer and change the share name to be the same as the 
printer driver name. Click Next. 
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 If you know the name of the computer the printer is plugged into, you can type 
this name into the Location field. In our example the computer name is 
Fredserver. This is optional. If you do not know the computer name leave the 
Location and comment fields blank and click Next. 
 

 

 Choose No to printing a test page and click Next. 
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 The installation of the driver is now complete. Click Finish. 
 

 

CONFIGURING THE PRINTER DRIVER 

 Go to Start > Settings > Printers & Faxes. 

 Right click on the COLDFOILS driver and left click on properties. 

 Left click on the Device settings tab. 

 Make all Cassettes not available. Change the Multi Purpose Feeder to A4 as 
shown in the screen shot below. 

 Click Apply when finished. 
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 Left click on the Advanced Tab. Left click on Printing Defaults button 
 

 

 Left click on the Paper/Quality tab, change the Paper Source to Multi Purpose 
Feeder. 

  Click Apply when finished. 
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 Left click on the Advanced Button. Set the Paper Size to A4. 

 Click OK and then Click OK again on the Paper/Quality Screen. 

 

 

 Left click on the General Tab. Left click on Printing Preferences. 
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 Change the Paper Source to Multi Purpose Feeder 

 Click Apply when finished  

 

 

 Left click on the Advanced Button 

 Set the Paper Size to A4.  

 Click OK and then click OK on the paper Quality Screen 

 

 

 Click OK on the General Tab to exit the Printer Properties. 
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KYOCERA PRINTER CONFIGURATION 

There are 3 settings on the Kyocera Printer which help control where a print job feeds 

from. To configure these settings best for MP tray printing please check the settings for 

MP Tray Mode, Feed Select and Override A4/LT by completing the next 3 steps.  

Step 1 - MP Tray Mode  

 Press the Menu/ Mode button on the printer 

 Down arrow until you get to Paper Handling 

 Right arrow to access the Paper Handling Menu 

 Down arrow until you get to MP Tray Mode 

 If MP Tray Mode is set to Cassette 
 

- Press Enter  
- Up arrow once so the setting shows to be First 
- Press Enter again to save this setting.  

 
If MP Tray Mode is already set to First continue on to Step 2. 

Step 2 - Feed Select  

 Down arrow until you get to the setting for Feed Select 

 If Feed Select is set to Cassette 1 or MP Tray 
 

- Press Enter 
- Up arrow until the setting shows Cassette 2 
- Press Enter 

 
If Feed Select is already set to Cassette 2 continue on to Step 3.  

Step 3 Override A4/LT 

 Down arrow until you get to Override A4/LT 

 If Override A4/LT is set to OFF 
 

- Press Enter 
- Up arrow once so the setting shows to be ON 
- Press Enter to save this setting 

 
Once this is saved or if Override A4/LT is already set to ON  

 Press the left arrow button to return to the Paper Handling Menu 

  Press the menu button to exit the Paper Handling Menu and exit the Menu 
Mode. 

If you are using an Output Tray –  

 Down arrow until you get to Paper Handling 

 Right arrow to access the Paper Handling Menu 

 Down arrow until you get to Stack Select 

 If Stack Select is set to TopTray FaceDn press Enter, down arrow to display 
RearTray FaceUp and press Enter again to save the selection. 

 Press the left arrow button to return to the Paper Handling Menu 

 Press the menu button to exit the Paper Handling Menu and exit the Menu Mode. 
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   99 

HOW TO RUN A FRED PAK UPDATE 
 
When a Fred Pak update becomes available, Fred Connect should download the update 

for you automatically.  

The next time you enter Fred Pak on any computer, you will be prompted with a 

message. (See screenshot below) 

Please note: Before Saying YES to the message you MUST run a full backup of your 

Fred Dispense and Fred Pak data. 

After a backup has been completed, it is recommended that you leave Fred Dispense 

and Fred Pak closed on all machines except for the computer running the update 

process.  

 Choose Yes to the following message. 

 

 After the update process has completed, choose Yes to start Fred Pak now 
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To run the Fred Pak update on a terminal 

 Open Fred Dispense and click on the Fred Pak Icon  <SHIFT + F6> to enter 

Fred Pak 

 Choose Yes to the following message. Please note that the local and main 

versions may be different to what is shown in this screen shot.  

 

 Choose Yes to the following message to start the Fred Pak program on the 

terminal. 

 




